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A quick guide to EndNote 20 
 

 

EndNote is bibliographic management software which allows you to create your own 

personal database of references - known as an EndNote 'Library'. EndNote works with MS 

Word to add citations to your work and automatically create correctly formatted reference 

lists.  

 

1:     Installing the software 

 

The EndNote 20 software is installed on all open-access PCs at Salford. You can also install 

it on your own device.  

o Before you begin the installation make sure all copies of Word and PowerPoint are 

closed. 

o Go to the Student Software Portal: https://lssoftware.salford.ac.uk and log in with 

your network username and password. 

o Click on EndNote so that it is highlighted, then scroll down to the bottom of the screen 

and click Next. 

o You will be given a link to install EndNote and a product key. Copy the product key. 

o Click the link, then click the link for the version of EndNote 20 you want – Windows or 

Mac. 

o Follow the EndNote installation instructions and enter the product key when 

prompted. 

 

2:     Creating an EndNote library 

 

o Click the Start button. 

o Scroll down to EndNote into the programs list, then click on the EndNote icon. 

o When EndNote opens, accept the licence agreement, then close the ‘Welcome to 

EndNote’ box (if it appears). 

o Go to the File menu and select New. 

o Make sure that you save your EndNote library to your C: drive, for example, your 

desktop or Documents folder. DO NOT save it on cloud storage. 

 

Note: You should only make ONE EndNote Library. You can save up to 100,000 references 

into an EndNote library, so it will be big enough.  Don’t make separate libraries for 

different assignments, etc. as this may lead to conflicts when you start using it with Word. 

You can make Groups (see p. 8) to organise your references. 

https://lssoftware.salford.ac.uk/
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You do not need to save your EndNote Library when you have finished working; it saves 

automatically as you add references to it. 

 

 

3:    Saving references from Science Direct 

 

o Open Google Chrome, go to the Library website: www.salford.ac.uk/library and 

open Library Search. 

o Click the Database Search link. 

o Type ScienceDirect into the Search box. 

o Click the Online access link. 

o Click the ScienceDirect link. 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type in your keywords, then 

click the Search icon. 

Click the 

checkboxes 

next to the 

articles you 

want, 

then go to 

the Export 

menu. 

http://www.salford.ac.uk/library
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The references you selected will be imported into your EndNote Library. 
 

 

4:    Editing records in EndNote  
 

Records saved from many databases will need some editing to ensure they generate 

correct APA 7th references. 

Click the download box to 

open it in EndNote. 

Click Export citation to RIS. 

Click on one of the records, so that it is 

highlighted, then click Edit. 
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Scroll down and look at the record: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5:    Saving references from Library Search  
 

o Go to the Library website: www.salford.ac.uk/library and open Library Search. 

 

Type in your keywords and click the search icon. 

When you have finished making your 

changes, click Save. 

If the DOI has been converted 

into a URL (as in this example), 

cut & paste it into the URL field. 

If there is already a URL there, 

delete it first. 

If it is a DOI (string of characters, 

not hyperlinked) leave it here. 

 

If there is an Article Number 

(instead of a range page numbers) 

in the Pages field, cut & paste it 

into the Article Number field. 

http://www.salford.ac.uk/library
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Click on the downloaded file to open it (as before). 

 

 

Check references for journal articles 

saved from Library Search – you may 

need to edit the Article Number if 

there is one (see p. 4). 

 

Records for books from Library  

Search may also need to be edited.  

 

 

 

 

 

 

 

 

 

 

When using our other databases or Google Scholar, look for a link called “Export”, 

“Download”, “Tools” or “Cite”, then choose the “EndNote” or “RIS” option to save 

references into EndNote. 

Click Export RIS,  

then click DOWNLOAD (you 

might to scroll down to see it). 

When you have found the record you want to 

save click the quote symbol ” next to it. 

Click Edit, then scroll down to the Edition field. 

If the word ed. or edition appear, delete it.  

The number needs to be written as a number, 

e.g. this example should be 4th 

Click Save when you have finished making the 

changes. 
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6:    Getting the full text  
 

So far, we have only been saving the bibliographic details (authors, titles, etc.) into 

EndNote. If an article has a DOI, and is from a journal the Library subscribes to, you can 

get EndNote to find and attach the fulltext article.  

 

Please note: this will only work with journal articles. Copyright law restricts the 

downloading of entire books.  

 

 

 

 

 

Go to All References then use Select All 

(Ctrl-A) to highlight all your references. 

Click the Search the Web icon (hover your mouse over 

the icons to find the correct one). 

EndNote will start searching for the full text. 

The paperclip icon indicates that a PDF has been attached. To open it, click to highlight 

the one you want, click the PDF tab, then select Open. 
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7:    Making manual references  

 

A few of our databases do not have the option to save references directly into EndNote, 

so you will need to make your own records for them. This is also the case with any material 

you find on the web, such as reports, newspaper articles, government documents, 

webpages, etc. 

 

 

 

 

 

 

 

 

Click the Add a new reference icon. 

This will open a blank form for you to 

fill in. 

Select the Reference Type, e.g. Web Page, Newspaper Article, Blog Post. 

Book is a good choice for most reports, standards, etc. 

Fill in the Author, Year, Title and URL fields, and 

Publisher if needed. 

Note: if the author is the name of an organisation (rather 

than a person) type a comma at the end of it. This will 

ensure correct formatting in your citations and reference. 

 

Click Save when you have finished. 
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8:    Making groups to organise your references  

 

You can create groups as you wish, in order to organise your references. You might wish 

to make groups for each chapter of your dissertation or thesis, or for different 

assignments you are working on. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to the Groups menu 

and select Create Group. 

 

A box will appear in the Groups 

pane. 

Type in a descriptive name for 

the group you have just made, 

then click the <Enter> key. 

If you are not already there, click All References, so all your references are displayed. 

You can then start filing references in groups by dragging and dropping them from the 

Reference List pane onto the group name. 
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Referencing 
 

You must acknowledge all the words, ideas or research of other authors you have used in 

your own writing. They must be referred to twice: 

 

1. In the body of your text, the author’s name and the date of the work, enclosed in 

parentheses. This is called an In-text Citation 

 

2. In a reference list (bibliography) at the end of your document. This has full details 

of the publication, such as author(s), title(s), publisher, volume and page numbers. 

This is called a Reference. 

 

Students on taught programmes (Undergraduate and Masters) must use the APA 7th 

style.  

 

EndNote works with Word to insert citations into your document and automatically create 

a correctly formatted list of references. This is all done using the “Cite While You Write” 

(CWYW) toolbar, which you will see in Word once you have installed EndNote on your PC. 

 

 

9:    Inserting citations into a document  

 

 

 

1. Open your EndNote library. 

2. Open your Word document. To practice you might like 

to use some “play” typing like this:  

 

 

 

 

 
3.  In the document click the place where you wish to place a citation in the text. Remember 

to leave a space between the last character and your cursor, and that your citation is placed 

before any punctuation (a comma or full stop).  
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In EndNote: 

 

 

 

 

4.  Click once to highlight 

the reference you want 

to use.  

5.  From the Tools menu select Cite While You 

Write (CWYW), then click Insert Selected 

Citation(s). 

Not what you were expecting to see?  

EndNote defaults to the ‘Annotated’ referencing style, which includes the 

abstract. To change it go to the Style menu and select APA 7th. 

 

6.  You should now see a citation in your text, and the 

first reference in a list at the end of your document. 
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10:    Direct quotes  

 

The APA 7th referencing style requires that a citation for a direct quote must include the 

page number where you found it.  

 

Remember that a direct quote should be placed in “quotation marks”, or indented from 

both margins if it is longer than two or three lines. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.  Insert your citation, then click on 

it, so that it is highlighted. 

Check that the 

correct citation 

is highlighted. 

The correctly formatted page number will now be added to the citation. 

2.   Click the Edit & Manage Citation(s) 

button on the CWYW toolbar. 

Type the page number(s) in the Pages box. You do not 

need to include p. or pp. – EndNote will do this for you. 

Click the OK button. 
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11:    Changing the citation format 

 

 In your writing you will often integrate the author’s name into your text, for example: 

 Ali et al. (2020) described the … 

 

In this case, you do not repeat the authors’ names in a citation at the end of the section.  

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To format your citation this way, place your 

cursor where you want the author’s name to be – 

usually this will be at the start of your 

paraphrase. 

Insert the citation in the usual way. 

Your citation will now be correctly 

formatted, i.e. authors’ names 

incorporated into the sentence, and 

followed by the date in parentheses. 

Right-click on the citation you have 

just inserted,  

 

go to Edit Citation(s) 

 

and select Display as: Author (Year). 
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12:    Adding multiple citations 

  

There will be times when you have summarised the content of two or more different 

papers into a single sentence or paragraph, and will need to insert a multiple citation. 

 

 

 

  

 

 

 

 

 

In your document, place your 

cursor where you need to put the 

citation. 

2.    From the Tools menu select Cite While You Write 

(CWYW), then click Insert Selected Citation(s).  

1.    In EndNote, hold down the <Ctrl> key while 

you select the references you wish to cite. 

The multiple citations will be inserted in your document in the correct format – all three articles 

are enclosed in one set of parentheses, in alphabetical order and separated by semicolons.  
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13:    Deleting citations 

 

Because of the large amount of coding behind each citation you insert, you cannot simply 

remove a citation by using the <Delete> key. Nor can you delete a citation you have put 

in the wrong place by using the ‘Undo’ button in Word.  

To remove a citation you must use the CWYW tools. 

 

Your citation, all its coding, and its matching reference (if this was the only citation for it) 

will now be removed cleanly from your document. 

 

 

Getting Help 

 

o More help with referencing and EndNote can be found on the Skills site:  

https://www.salford.ac.uk/skills/referencing/apa-7th-edition 

o If you have any enquiries please contact the Academic Support Librarian for your 

subject area. Their details can be from the Choose a subject menu at:  

    http://bit.ly/sflsubject 

Click the arrow on the Edit Reference button, 

and select Remove Citation.  

 

Click on the citation so it is highlighted, then 

click the Edit & Manage Citations button. 

 

Click the OK button. 

 


